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About this Guide

This user guide provides instructions for installing and managing the Aruba AirMesh wireless mesh devices
using the MeshConfig tool. This chapter covers the following:

e “Audience” on page 11

e “Fundamentals” on page 11

e “Related Documents” on page 11
e “Conventions” on page 12

e “Contacting Support” on page 12

Audience

This guide is intended for system integrators and resellers responsible for managing networks that consist
of the MSR series routers and the MST terminal device. This guide assumes that you have basic knowledge
in Layer 2 and Layer 3 networking technologies.

Fundamentals

Throughout this document references are made to routers. The following AirMesh routers are available for
configuration:

e MSR1200
e MSR2000
o MSR4000.
In addition to the above the following MST terminal device is also available for configuration:

o MST200

Configuring your router is accomplished using either the Web-based Management Interface (WMI) or the
command line interface (CLI).

The screenshots and examples in this guide are for demonstration purposes only. The exact output of the
commands may vary depending on the version of the MeshConfig used as well as the model and firmware version
NOTE of the router hardware.

Related Documents

The following items are part of the complete documentation for the Aruba MeshOS network:
o Aruba MeshOS 4.4 Quick Start Guide

o Aruba MeshOS 4.4 User Guide

o Aruba MeshOS 4.4 Command Line Reference Guide

o Aruba MeshOS 4.4 Release Notes

o Aruba MeshConfig 4.4 Release Notes

o  MSR/MST Installation Guides

MeshConfig 4.4 | User Guide About this Guide | 11



Conventions

The following conventions are used throughout this manual to emphasize important concepts:

Table 1 Typographical Conventions

Italics

System items

Commands

<Arguments>

[Optional]

{Item A | Item B}

This style is used to emphasize important terms and to mark the titles of books.

This fixed-width font depicts the following:

o Sample screen output

o System prompts

o Filenames, software devices, and specific commands when mentioned in the
text

In the command examples, this bold font depicts text that you must type exactly as
shown.

In the command examples, italicized text within angle brackets represents items
that you should replace with information appropriate to your specific situation. For
example:

# send <text message>

In this example, you would type “send” at the system prompt exactly as shown,
followed by the text of the message you wish to send. Do not type the angle
brackets.

In the command examples, items enclosed in brackets are optional. Do not type the
brackets.

In the command examples, items within curled braces and separated by a vertical
bar represent the available choices. Enter only one choice. Do not type the braces
or bars.

The following informational icons are used throughout this guide:

Indicates helpful suggestions, pertinent information, and important things to remember.

NOTE

Indicates a risk of damage to your hardware or loss of data.

C AN

Indicates a risk of personal injury or death.

NAX XN

Contacting Support

Main Site

Support Site

arubanetworks.com

support.arubanetworks.com

12 | About this Guide
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http://www.arubanetworks.com
http://www.arubanetworks.com
https://support.arubanetworks.com
https://support.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)
1-408-754-1200

International Telephones arubanetworks.com/support-services/aruba-support-program/contact-support/
Software Licensing Site licensing.arubanetworks.com/login.php
Wireless Security Incident arubanetworks.com/support/wsirt.php

Response Team (WSIRT)

Support Emails

Americas and APAC support@arubanetworks.com
EMEA emea_support@arubanetworks.com
WSIRT Email wsirt@arubanetworks.com

Please email details of any
security problem found in an
Aruba product.

MeshConfig 4.4 | User Guide About this Guide |
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Chapter 1

This chapter consists of general information on the MeshConfig tool including information on installing and
initial set up of the tool. The information is organized in the following sections:

e “Introduction to MeshConfig” on page 15
e “Installing MeshConfig” on page 16

e “Getting Started” on page 20

e “Changing the Password” on page 22

e “Logout” on page 23

e “Accessing the Online Help” on page 23

e ‘“Installing the Java Runtime Engine” on page 24

Introduction to MeshConfig

The MeshConfig tool is a management system for small networks of Aruba AirMesh wireless mesh routers.
You can use this tool to configure and monitor Aruba mesh networks and to realize video surveillance.

Hardware and Software Specifications

The hardware and software specifications for the MeshConfig tool are as follows:

Hardware Specifications

For installations with up to 50 nodes:
o 4 core 2.0 GHz CPU

o 2GBRAM

o b5 GB free disk space

For installations greater than 50 nodes:
e 512 MB RAM for every additional 50 nodes
o b GB disk space for every additional 50 nodes

For example, when MeshConfig manages 250 nodes, 4 core 2.0GHz CPU, 4GB RAM and 25GB disk space are
needed. These 250 nodes can provide access service for up to 5000 clients.

The network should have no more than 250 MSR and/or MST nodes. A node can provide access services for up to

20 clients.
NOTE

Software Specifications

The software specifications for the MeshConfig tool are listed in Table 2.
Table 2 Software Specifications

Windows OS Server: Windows 2008 server R2 standard (recommended)
Client: Windows XP/Windows7

MeshConfig 4.4 | User Guide Basic | 15



| Basic

Table 2 Software Specifications

Browsers Internet Explorer 7.0/8.0
Firefox 3.6
Web server TomCat 5.0
Database MySQL 5.0
Java JRE 1.6
To install MeshConfig:

1. Start the installation process by launching the installation wizard for MeshConfig using the MeshConfig

Install.exe file.

Figure 1 MeshConfig Install Wizard

The MeshConfig Install screen is displayed as shown in

MeshConfig 4.4 | User Guide



Figure 2 Install Screen

You can directly upgrade to the current version of the tool without having to uninstall the older version. This
support is available only from MeshConfig 4.2 onwards. The upgrade process will detect the environment, backup
NOTE your data, install the new version, and restore the data from the previous version automatically.

2. Click on Next to proceed with the Installation.
Use the Cancel button to exit the wizard.

3. Select an installation folder.

The default installation folder is C:\\Program files\MeshConfig.Click on Choose to browse to an
alternative folder or path. Use Restore Default Folder to go back to the default installation folder.

4. Click on Next to proceed.

Figure 3 Installation Folder

5. Specify a shortcut folder option and click on Next to proceed.
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Figure 4 Shortcut Folder

The pre-installation summary is displayed as shown in Figure 5.

Figure 5 Pre-installation Summary.

6. Click on Install to start installing the MeshConfig files.

| Basic MeshConfig 4.4 | User Guide



Figure 6 Installing MeshConfig

A progress bar indicates the progress of the installation. The Install Complete screen as shown in
Figure 7 is displayed once the installation is complete.

7. Click on Done to conclude the installation process and exit the wizard.

Figure 7 Installation Complete

A new menu group as shown in Figure 8 is created in the Windows start up menu.

MeshConfig 4.4 | User Guide Basic |



Figure 8 MeshConfig Group in the Start up Menu

The following operations can be performed directly from the MeshConfig menu group:

Start MeshConfig

Use this option to start the MeshConfig services and automatically open the default web browser, to
display the login page.

Stop MeshConfig

Use this option to stop the MeshConfig services without closing the WebUI.

Backup MeshConfig

Use this option to backup the MeshConfig configuration and database files to a folder of your choice.
Restore MeshConfig

Use this option to restore the configuration and database files from the backup folder.

Repair MeshConfig

Use this option to repair the mysql database in case of a database crash.

Reinitialize Meshconfig

Use this option to reinitialize the mysql database if the Start MeshConfig option is not effective after
an upgrade or if you want to clear the MeshConfig database.

Uninstall MeshConfig
Use this option to uninstall MeshConfig.

NOTE

| Basic

Stop all MeshConfig services before you select the Backup, Restore, Repair, Reinitialize, and Uninstall
MeshConfig options.

The MeshConfig tool has a web-based interface for remote access. The MeshConfig web server is installed
on the Windows Server. You may also run MeshConfig clients from a PC or laptop.

The following steps will guide you to set up the MeshConfig tool:
1. Launch the MeshConfig tool

a. On the server:

Launch the MeshConfig tool using Start Menu > All Programs > MeshConfig > Start
MeshConfig. A start up window as shown in Figure 9 is displayed.
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Figure 9 Launching MeshConfig

A progress bar indicates the status. A login page as shown in Figure 10 is displayed when the
progress bar reaches 100%.

b. As a client:

Open the web browser in a laptop or PC and enter the URL for example, http://A.B.C.D:9090/
LoginPage.do, where A.B.C.D is the IP address of the server. For example, 192.168.10.1. A login page
as shown in Figure 10 is displayed.

2. Login to the MeshConfig user interface (UI).
The default login is:
Username: root

Password: public

| ! We strongly recommend changing the default credentials, in order to prevent unauthorized access to the router.

T Refer to “Changing the Password” on page 22 for details.

Figure 10 Login Screen

After successful login, the home page as shown in Figure 11 is displayed.
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Figure 11 Home Page

3. Add mesh nodes and mesh networks.
Use the following options in the System page to populate the MeshConfig tool with data.:
Add Node: Adds the node with the specified IP address.
Add Mesh Network: Adds a mesh network with the specified gateway and parameters.

Auto Discovery: Automatically discovers and adds mesh networks based on the specified IP or a
range of IPs with the netmask.
For further details refer to “Adding a Node” on page 86, “Adding a Mesh Network” on page 86, and
“Upgrading Nodes” on page 82.

Links to these options are also available on the Home page.

NOTE
The mesh nodes are added to the inventory and are available on the Inventory page. For further details
refer to Chapter 2, “Inventory View” .
MeshConfig automatically discovers the parent network of a node and adds it to the database.
NOTE

4. (Optional) Configure the following initial parameters:
Device Status Polling Interval: 30 Seconds.
You can modify this parameter. The recommended value is 30 seconds or above.
Performance Data Polling Interval: 15 Minutes.
You can modify this parameter. The recommended value is 5 Minutes or above.
Auto Discovery Interval: 24 hours.
Real-time Reports Data Store Time Length: 7 Days.
You can modify this parameter. The range is 1 day - 90 days.

Periodicity Reports Data Store Times Length: 30 Days.

To change the login password:
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1. Click on the Change Password option located at the top right hand corner of the MeshConfig page as
shown in Figure 12.

Figure 12 Changing the Password
Vlesh@enig

The Change Password window is displayed as shown in Figure 13.

Q nanée Passwurgg

Home | Map | Invemtory | Alert | Provisioning | Upgrade | Client | System | Report

Figure 13 Change Password Window

2. Enter the Current Password, New Password, and the Password Expiry Duration (optional) and
click on Submit.

The password is changed to the specified string. Use the Reset button to reset the password to the
default password.

To logout, click on the Logout link located at the top right hand corner of the MeshConfig page as shown in
Figure 14. Alternatively, you can also click on the [root] link.

Figure 14 [ ogout Option

Change Password |JLogout [ root] ?%’

To access the online help file, click on the help icon as shown in Figure 15. The help instructions are
displayed in a separate window.
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| Basic

Figure 15 Online Help

Change Password | Logout | root E%’

The Java Runtime Environment (JRE) version 1.6 or higher is recommended on the client side for the
MeshConfig tool. The Map view may not display without the recommended version of JRE.

| | This requirement is applicable only for the client. At the server end, MeshConfig automatically registers to
the browser.
NOTE

To upgrade to the recommended version or to install the JRE on the client, and register it to the browser:

1. Click on the Java icon at the top right hand corner of the MeshConfig page as shown in Figure 16.

Figure 16 Java Runtime Environment

Change Password | Logout [ root] ?@

A download dialog is displayed. Click on the Run button to install JRE on the client and register it to the
browser.
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Chapter 2

Inventory View

The Inventory page is used to configure the settings and perform operations specific to each wireless mesh
node. This chapter consists of the following:

e “Viewing the Routers” on page 25

e “Naming the Routers” on page 26

e “Setting/Removing a Node as Gateway” on page 27

e “Viewing Router Properties” on page 29

e “Checking Router Connectivity” on page 31

e “Viewing Real-time Performance Statistics” on page 32
e “Router Operations” on page 34

e “Viewing a Mesh” on page 35

e “Viewing a Mesh Link” on page 36

e “Link Operations” on page 36

e “Viewing a SSID” on page 38

Viewing the Routers

MeshConfig displays a list of all the routers that make up the mesh networks that it manages, on the
Inventory page.

To view the list of routers:
1. Click on the Inventory tab.

A list of all the routers is displayed as shown in Figure 17.

Figure 17 Viewing the Routers

Use the Page Length option above the router list to set the page length of the list and the refresh button
beside it to refresh the Inventory page. You can also search the Inventory page to locate routers matching
a specific value for the column attributes, using the Search button. For example, the search option
“Column DeviceName Contain z” displays all the routers with the string “z” in their Device Name.
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By default, routers are assigned hostnames based on their model type, for example, MST200. It is

recommended that each router is assigned a unique and meaningful name to identify and manage the nodes
effectively.

To change the hostname of a router:
1. Click on the Inventory tab.

A list of all the routers is displayed as shown in Figure 18.

Figure 18 Inventory Page

2. Use the Serial Number details to locate the node to be configured using the Search button and check
the box in front of it.

3. Click on the Modify button located above the router list and select the Hostname option as shown in
Figure 19.

Figure 19 Modifying a Hostname

4. Enter the new hostname in the Modify Router Hostname page and click on Submit as shown in
Figure 20.
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Figure 20 Specifying the New Hostname

Medify Router Hostname

Host Mame zhiyuan-B|

The hostname of the router is changed as shown in Figure 21.

Figure 21 New Hostname

A mesh network should have at least one gateway node that uses its Ethernet port to connect the mesh
network to the wired network or to servers such as video servers, video decoders, and internet routers.
Gateways do not need to be explicitly configured. However, marking a node as a gateway simplifies the
management of these nodes. For example, the power LED on each node can indicate whether it has found a
routing path to one of the gateways. This feature would not be available unless the gateway nodes has been
explicitly specified in a mesh network.

To set/remove a node as gateway:
1. Click on the Inventory tab.
A list of all the routers is displayed
2. Check the box in front of the node to be set/removed as a gateway

3. Click on the Modify button located above the list of routers and select the Set as Gateway to set the
node as a gateway. Use the Set as Non-gateway option to remove this setting.

MeshConfig 4.4 | User Guide Inventory View |



Figure 22 Set as a Gateway Node

4. Click on Yes in the confirmation dialog that is displayed.
5. A Configuration Report as shown in Figure 23 is displayed.

6. Wait until the Total Progress bar reaches 100% and the Success count is increased as shown in Figure

23.

Figure 23 Configuration Report

7. Check on the Inventory tab to display the Inventory page. The node Type for the node is changed to
Gateway as shown in Figure 24.
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Figure 24 Changing a Node to Gateway

Home | Map | Imvemtorr | Alert | Provisioming | Upgrade | Client | System

Change Password

Routers

Page Length 25 W 1to7ofT = Column Device Name

O Device Name Serial Number  Running Image Stored Image  Active Partition
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The menu options in the Inventory page are enabled based on the number of nodes selected. For example, if no
node is selected, only the Query->Update option is enabled. If two nodes are selected, the menu options that
NOTE require the selection of up to two nodes are enabled. For example, Configuration->Set Preferred Link option.

MeshConfig collects a summary of the key information for each node.

To review this summary:

1. Click on the Inventory tab.
A list of all the routers is displayed.

Select a router by marking the check box in front of it.

3. Click on the Query button above the list of routers and select the Property option to view the router

properties as shown in Figure 25.

Figure 25 Router Property Option

4. The System Summary for the router is displayed as shown in is Figure 26.
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Figure 26 System Summary of a Router

G If this report is not displayed, check your browser settings and enable the display of popup windows.
NOTE

5. Click on the Alerts icon on the left pane of the window to see the summary of alarms on the router as
shown in Figure 27.

Figure 27 Summary of Alerts on a Router
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6. Click on the Interface icon on the left pane of the window to see the summary of interfaces on the
router as shown is Figure 28.

Figure 28 Summary of Interfaces on the Router

Interface summary of device

Interface Total
5
System
Interface:dot1 1radio 0
= | Admin Status Up Operate Status Up
g Usage Mode Access Physical Mode 802.11na
Alerts Channel 140 IfPhysAddress 00:17:7b:28:6c:76
Interface:dot1 1radic Ofwds 7
F— % Admin Status Up Operate Status Up
LZ“.: RS5I e SHR e
Interface Interface:dot1 1radic 1
Admin Status Up Operate Status Up
p @ Usage Mode Access Physical Mode 802.11na
Lﬂ}) Channel 100 IfPhysAddress 00:17:7b:2a:8c77
551D Interface:dot1 1radic 1/wds 7
Admin Status Up Operate Status Up
RS5I 40 SHR 40

Interface:gigabit-ethernet 0

IP Address 24221 IP Mask 255.255.255.0
Admin Status Up Operate Status Down
Interface Speed 10M IfPhysAddress 00:17:7b:2a:8c75

7. Click on the SSID icon on the left pane of the window to see the summary of SSIDs on the router as
shown is Figure 29.

Figure 29 Summary of SSIDs on the Router

MeshConfig allows you to check the connectivity to a router using the Ping and Traceroute tools.

Using the Ping Tool
1. Click on the Inventory tab.
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A list of all the routers is displayed.
Select a router by marking the check box in front of it.
Click on the Query button above the list of routers and select the Ping option.

The result of the ping command is displayed as shown in Figure 30.

Figure 30 Ping Command

Ping zhiyuan-6 Result

Pinging 10.€5.12.21€ with 32 bytes of data:

Reply from 10.€5.12.21€: bytes=3Z time=55Tms TTIL=5%
Reply from 10.€5.12.21€: bytes=3Z time=55lms TTL=5%
Request timed out.

Reply from 10.€5.12.21€: bytes=3Z time=558ms TTL=5%

Ping statistics for 10.65.12.216:
Packets: Jent = 4, Received = 3, Lost = 1 [25% lo=s),
Approximate round trip times in milli-seconds:
ini = 55ims, 5 = 558ms, 3 ge = 555m=

Using the Traceroute Tool
1. Click on the Inventory tab.
A list of all the routers is displayed.
Select a router by marking the check box in front of it.
3. Click on the Query button above the list of routers and select the Traceroute option.

The result of the traceroute command is displayed as shown in Figure 31.

Figure 31 Traceroute Command

Trace Route to zhiyuan-6 Result

Tracing route to 10.€5.12.21€ over a maximum of 20 hops

€ ms 3 m= 3 ms 10.13.108.254

3 m= 3 m= 3 ms 10.13.2.1
552 m=s 571 m= 572 m= 10.€4.56.2
579 m= 555 m=s 566 m= 10.64.56.1

- - - Request timed out.
€12 ms €22 m=s €21 m= 10.65.12.21€

Mmoo R

Trace complete.

MeshConfig supports the real-time collection and display of Key Performance Indicators (KPIs) on each
router.

To monitor the KPIs of a router:
1. Click on the Inventory tab.
A list of all the routers is displayed.
Select a router by marking the check box in front of it.

3. Click on the Query button above the list of routers and select the System Statistics option to view the
Realtime System Information as shown in Figure 32.
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Figure 32 Realtime System Information

Realtime System Information

Device: zhiyuan-§

Hame Value
Pall Time Tue Apr03 12:34:40 IST 2012
CpulLoadPercentage1Min 30%
MemoryTotal 128548KB
MemoryFree 44820KB
MemaoryUsedPercentage B54%
StorageTotal 3392KB
StorageFree 1838KB
StoragellsedPercentage 48%
Hardware Temperature nc
Hardware\ersion Al
| i This window displays the KPI for the system such as CPU usage, memory usage, flash usage, and hardware
temperature. Use the Refresh button to update the values.
NOTE
To view the real-time interface information of a router:
1. Click on the Inventory tab.
A list of all the routers is displayed.
Select a router by marking the check box in front of it.
Click on the Query button above the list of routers and select the Interface Statistics option to view
the Realtime Interface Information as shown in Figure 33.
Figure 33 Realtime Interface Information.
Realtime Interface Information
Device: zhiyuan-§
. . Total
Admin  Operation Current Rx Current Tx D
Inferface Name ;| st Rate{Bytes/s) Rate{Bytesis) :
imes
gigabit-ethermet 0 up down a a a
dot11radic Ofwds 1 up up 5012 TOT 1
dot11radic 0 up up 38450 5995 a
dot11radio 1 up up 40372 11346 a
dot11radic 1/wds 1 up up 3843 228 1
dot11radio 1/wds 7 up up 5558 28685 1
This window displays the statistics for all the interfaces in the system, such as Ethernet ports, radio ports, and
WDS link ports. Use the Refresh button to update the values.
NOTE

To view the real-time client Information of a router:

1. Click on the Inventory tab.
A list of all the routers is displayed.
2. Select a router by marking the check box in front of it.

3. Click on the Query button above the list of routers and select the Client Statistics option to view the
Realtime Client Information as shown in Figure 34.
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NOTE

| Inventory View

Figure 34 Realtime Client Information

Realtime Client Information

Device: MER2000-66-7e-05

Cnline  Current  Current fvarage  Average Total Total Asgsociated

551D MAC IP RS

length  Upstream Downstream Upstream Downstream Uplead  Download Radio

swvei-hes 0017.78:00:08:08 10551413 26:40:38 0 Kbis 0 Khis 127 Kiiz D48 Kbis 18201825 6012840 Radiol 13

This window displays details on all of the wireless clients associated on the router. Client statistics such as
traffic load, online time, and other important information is displayed for each client.

The following are the other router operations available on the Inventory page:

The menu options in the Inventory page are enabled based on the number of nodes selected. For example, if no
node is selected, only the Query->Update option is enabled. If two nodes are selected, the menu options that
require the selection of up to two nodes are enabled. For example, Configuration->Set Preferred Link option.

Query > Alert

This operation performs a search for the active alarms for the selected router and displays them in a
table.

Query > Update

This operation performs an instant refresh of the router status. Use this option if you want to refresh the
values immediately. The automatic refresh cycle of MeshConfig occurs every 30 seconds (default). You
can also configure the duration of the refresh cycle.

Modify > IP Address

This operation modifies the IP address of the selected router. If the router is the master node, you need
to reattach MeshConfig to the master node via the new IP address.

Modify > Delete
This operation deletes the selected routers from the MeshConfig tool.
WMI > Home

This operation opens the Web-based Management Interface (WMI) for the selected router. The WMI
provides in depth configuration and troubleshooting for the individual routers. The username/password
of the router is required. For further information, refer to the Aruba MeshOS 4.4 User Guide.

WMI > Radio Interface

This menu item brings up the Radio Settings WMI Page for the router. The username/password of the
router is required. For further information, refer to the Aruba MeshOS 4.4 User Guide.

WMI > DHCP Server

This menu item brings up the DHCP Settings WMI Page for the router. The username/password of the
router is required. For further information, refer to the Aruba MeshOS 4.4 User Guide.

WMI > Routing Table

This menu item brings up the Routing WMI Page for the router. The username/password of the router is
required. For further information, refer to the Aruba MeshOS 4.4 User Guide.

WMI > AVT
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This menu item brings up the Active Video Transport Settings WMI Page for the router. The
username/password of the router is required. For further information, refer to the Aruba MeshOS 4.4
User Guide.

WMI > Troubleshooting

This menu item brings up the Troubleshooting WMI Page for the router. The username/password of
the router is required. For further information, refer to the Aruba MeshOS 4.4 User Guide.

All these operations can also be accessed from the Map view of a mesh network. Open the topology map of a
mesh network and right-click on a router. The router operations are available in the menu options as shown in
NOTE Figure 35.

Figure 35 Router Operations in Map View

MeshConfig display a list of all the mesh networks that it manages in the Inventory page.
To view the list of the mesh networks:

1. Click on the Inventory tab in the MeshConfig tool to display the Inventory page.
2. Select the Mesh Networks link in the menu tree.
The list of all the mesh networks managed by the tool is displayed in the Inventory page as shown in

Figure 36.

Figure 36 Mesh Networks Page

Use the Page Length option above the list to set the page length of the list and the refresh button beside it
to refresh the Inventory page. You can also search the Inventory page to locate mesh networks matching
a specific value for the column attributes using the Search button. For example, the search option
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“Column MeshID Contain Default” displays all the mesh networks with the string “Default” in their
MeshlID.

MeshConfig displays a list of all the mesh links in the networks that it manages.
To view the list of the mesh links:
1. Click on the Inventory tab in the MeshConfig tool to display the Inventory page.
2. Select the Links option in the menu tree.
The list of all the mesh links in the mesh networks managed by the tool is displayed in the Inventory

page as shown in Figure 37.

Figure 37 Mesh Links Page

Use the Page Length option above the list to set the page length of the list and the refresh button beside it
to refresh the Inventory page. You can also search the Inventory page to locate links matching a specific
value for the column attributes using the Search button. For example, the search option “Column
DeviceName Contain z” displays all the links formed with devices containing the string “z” in their Device
Name.

The following are the operations that you can perform on the mesh links:

Real-time Info

This operation queries the real-time information for the selected link and displays it in the form of a table.
To view the real-time information of a link:

1. Click on the Inventory tab in the MeshConfig tool to display the Inventory page.

2. Select the Links option in the menu tree.

The list of all the mesh links in the mesh networks managed by the tool is displayed in the Inventory
page.
3. Select the link by marking the check box in front of the link.
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4. Click on the Realtime Info button above the link list. The Realtime Link Information page is
displayed as shown in Figure 38.

Figure 38 Realtime Link Information

Realtime Link Information

Router Name zhiyuan-2 zhiyuan-1

Interface Name dot11radic 1/wds 7 null

Channel 900 802.11na ch 100 900 802.11a ch 140

Admin Status Up Down

Physical Status Up Down

RSSI 41 null

SNR 41 null

Ngise Floor -117dBm -112dBm

Data Rate 120Mbi's NiA

Link Quslity T1% null%

Security Policy WPRAZ Invalid

Cumrent Tx Rate 5.98 Kbis NiA
Modify

This operation modifies the radio setting of the selected link.

To modify the Link Radio Setting of a link:

1. Click on the Inventory tab in the MeshConfig tool to display the Inventory page.
2. Select the Links option in the menu tree.

The list of all the mesh links in the mesh networks managed by the tool is displayed in the Inventory
page.

3. Select the link by marking the check box in front of the link.

4. Click on the Modify button above the link list. The Link Radio Setting page is displayed as shown in

Figure 39.

Figure 39 Link Radio Setting Page

5. Modify the parameters and click the Configure button to apply the changes.

Update

This operation performs an instant refresh of the link status. Use this option if you want to refresh the
values immediately. The automatic refresh cycle of MeshConfig occurs every 30 seconds (default). You can
also configure the duration of the refresh cycle.

To update a link:

1. Check the box next to the link to select the link
2. Click on the Update button above the link list.
The link is updated immediately.

Disallow Links

This operation blocks a link in a mesh network from forming.
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To disallow a link:

1. Check the box in front of the link to select the link.

2. Click on the Disallow button above the list. The link is disallowed with immediate effect.

MeshConfig display a list of all the SSIDs in the networks that it manages, in the Inventory page.
To view the list of SSIDs:

1. Click on the Inventory tab in the MeshConfig tool to display the Inventory page.

2. Select the SSIDs link in the menu tree.

The list of all the SSIDs in the mesh networks managed by the tool is displayed in the Inventory page as
shown in Figure 40.

Figure 40 SSI/Ds Page

Use the Page Length option above the list to set the page length of the list and the refresh button beside it
to refresh the Inventory page. You can also search the Inventory page to locate SSIDs matching a specific
value for the column attributes using the Search button. For example, the search option “Column SSID
Contain z” displays all the SSIDs with the string “z”.
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Chapter 3

Map View

The Map view feature lets you view the topology maps for the mesh networks and perform operations on
the maps. This chapter explains the following:

e “Viewing the Map” on page 39

e “Map Operations” on page 41

e “Removing/Disallowing Links” on page 43
e “Configuring Preferred Links” on page 45
e “Modifying Links” on page 47

e “Monitoring the Link Quality” on page 48
e “Recovering Orphaned Nodes” on page 50

e “Mesh Operations” on page 52

E The JRE version 1.6 or higher is recommended on the client side for the MeshConfig tool. The Map view

NoTa may not display without the recommended version of JRE.

Viewing the Map

MeshConfig displays the maps of the networks that it actively manages, in the Map view.
To view the map of a mesh network:

1. Click on the Map tab.

The list of all the mesh networks in the MeshConfig tool are listed in the left navigation pane. The networks
are pictorially represented in the right pane of the page as shown in Figure 41.

The pictorial representation displays the Mesh ID and the client count for each mesh network.

NOTE

MeshConfig 4.4 | User Guide Map View | 39



Figure 41 Map View

2. Click on the Mesh ID in the left pane to display the mesh map for a particular mesh network as shown in
Figure 42.

Figure 42 Mesh Network View

The pictorial representation of a mesh network displays information such as Hostname of the routers in
the network, the links, the strength of the links (indicated by the color and thickness of the links),
NOTE information on the gateway nodes and the client count for each node.
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The following operations can be performed in the topology map of a mesh network:
“Customizing the Map Background” on page 41
“Customizing Node Locations” on page 42
“Removing/Disallowing Links” on page 43
“Configuring Preferred Links” on page 45
“Modifying Links” on page 47
“Monitoring the Link Quality” on page 48

“Recovering Orphaned Nodes” on page 50

Customizing the Map Background
To customize the map background:

1. Open the mesh map of the mesh network.

2. Right-click on the map background and select the Modify Background option as shown in Figure 43.

Figure 43 Modifying the Map Background

3. The Back Ground Image Management window is displayed as shown in Figure 44.
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Figure 44 Background Image Management

D If this window is not displayed, check the browser settings and enable pop-ups in the browser.
NOTE

4. Browse and select the new background image file.
The image can be a Google earth screen capture, street map, campus map, or a building layout diagram.
5. Click on Set as Background to upload the new image to MeshConfig.

The background image of the map is changed with immediate effect.

Customizing Node Locations

The MeshConfig topology map is regenerated and the new nodes are automatically placed within the map
using a ring-like pattern, whenever the tool attaches to a new network. The location of the nodes within the
map can be customized as follows:

1. Open the topology map for a mesh network.
2. Click on the nodes and drag them to the desired locations.

3. Right-click on the map background and select Save All Router Location to save the changes as shown
in Figure 45.
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Figure 45 Customizing Node Location

Use the Refresh Map option to discard the changes and go back to the previous status.

Removing/Disallowing Links

The mesh nodes are designed to automatically form links with other nodes. The default network topology
should be enough to meet most of the requirements. However, MeshConfig tool allows you to remove a
formed link or disallow any two nodes from forming a link. This feature is useful when:

A formed link is often down (indicated using red lines in the topology map)
A formed link is not of high quality (indicated using yellow or orange lines in the topology map)
The physical distance between two nodes is too far (over 500 meters)

There are several alternative, multi-hop connections between two nodes that would be preferred over a
direct link between them.

One node may have too many links, causing too much load or interference.

The topology formed does not match a pre-designed topology plan.

Check List before Disallowing Links

Check the following conditions before disallowing any link:

Given the physical characteristics of the two linked nodes, is the performance of the link reasonable?

If not, check to see if there are physical factors that are abnormally degrading the link. These factors
include, but are not limited to:

Interference
Disruption in the Line of Sight
Faulty antenna or radio hardware
Mismatch between radio and antenna
Faulty or damaged antenna cable connections
Incorrect antenna alignment
Misconfiguration of country code or transmission power
Is there an alternative routing path between the two linked nodes?

Make sure that, by disallowing the link, no node would lose connectivity to the mesh network.
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Disallowing Links

After performing the checks specified in the checklist above, if it is determined that a link should be
disallowed, use the following steps to disallow a link:

1. Click on the Mesh ID of the mesh network in the Map view to open the topology map for the mesh
network.

2. Click on a formed link between two nodes to select the link as shown in Figure 46.

Figure 46 Selecting a Link

Alternatively, use CTRL + Left Mouse button to select the two nodes as shown in Figure 47.

Figure 47 Selecting the Nodes

3. Right-click on the selected link and select the Disallow Link option from the menu as shown in Figure
48.
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Figure 48 Disallow a Link

Alternatively, right-click on one of the two selected nodes and choose the menu item Configuration >
Disallow Link as shown in Figure 49.

Figure 49 Disallow a Link at the Node

4. A confirmation dialog box is displayed. Check again to ensure the link should be disallowed and click on
Yes to confirm.

This change may take some time to take effect. During this process it is normal for the MeshConfig tool to lose

connection to some of the nodes in the network.
NOTE

Configuring Preferred Links

MeshConfig allows you to configure preferred links between two neighbors. This feature can be used to
encourage the nodes to form a link.

To configure a preferred link:

1. Select the two nodes in the topology map using CTRL + Left Mouse button as shown in Figure 50.
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Figure 50 Selecting Nodes for a Preferred Link

2. Right click on one of the two nodes and select the menu item Configuration > Set Preferred Link as
shown in Figure 51.

Figure 51 Configuring a Preferred Link

3. A confirmation dialog box is displayed. Check again to ensure the link should be disallowed and click on
Yes to confirm.

This change may take some time to take effect. During this process it is normal for the MeshConfig tool to lose
connection to some of the nodes in the network.

NOTE
| é The formation of a preferred link depends on other physical conditions such as Line of sight, signal quality, and
T such other factors. This configuration does not guarantee the formation of a link between the two nodes.
| Map View
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To remove the preferred link configuration between two nodes:

1. Select the two nodes in the topology map using CTRL + Left Mouse button.

2. Right click on one of the two nodes and select the menu item Configuration > Unset Preferred Link.

There is an important difference between the option Unset Preferred Link and Disallow Link. The Unset
Preferred Link option discourages two nodes from forming a link but it does not prevent them from doing so. The
NOTE Disallow Link option prevents two nodes from forming a link.

Modifying Links
MeshConfig allows you to modify the Radio mode and channel parameters of a link.
To modify a link:

1. Click on the Mesh ID of the mesh network in the Map view to open the topology map for the mesh
network.

2. Select a formed link between two nodes by clicking on the link.

3. Right-click on the link and select the menu item Modify Link as shown in Figure 52.

Figure 52 Modifying a Link

4. The Link Radio Setting page is displayed as shown in Figure 53.
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Figure 53 Radio Link Setting

5. Set the Radio Mode and Channel values for the link.
6. Click on the Configure button.
This will lock the radios at the two ends of the link to the specified Mode and Channel.
7. Click OK at a second confirmation dialog.
8. The configuration report which tracks the progress is displayed.

The configuration is complete when the Progress column shows 100% for both the nodes.

It may take sometime for the above configuration to be completed as mesh links may need to reform. It is normal

for one of the two nodes to temporarily lose its connection to the MeshConfig tool and time out.
NOTE

Monitoring the Link Quality
You can monitor the performance of each link in a mesh network for individual nodes.
To monitor the link quality of a link:

1. Click on the Mesh ID of the mesh network in the Map view to open the topology map for the mesh
network.

2. Select a formed link between two nodes by clicking on the link.

3. Right-click on the link to select the Realtime-Info option from the menu as shown in Figure 54.
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Figure 54 Realtime Information on a Link

4. The Realtime Link Information window is displayed as shown in Figure 55. This window contains the
information on the link statistics.

Figure 55 Realtime Link Information

Realtime Link Information

Router Name CentralOffice Middle-1
Interface Name dot11radio 1iwds 0 dot11radio 1/iwds 7
Channel U3 802.11na ch 165 U3 802.11na ch 165
Admin Status Up Up
Physical Status Up Up
RSS! 30 34
SMNR 30 34
Moise Floor -117dBm -108dBm
Data Rate 130Mbis 117Mbis
Link Quality 3% 75%
Security Policy WPAZ WPAZ
Current Tx Rate 313 Kbis 0.54 Kbis
| Refresh |

The link statistics information is listed in Table 3.

Table 3 Link Statistics

mm

Interface Name
Channel

Admin Status
Physical Status

RSSI

SNR

The radio interface details
The channel details

The admin status of the link.
The physical status of the link.

The Receive Signal Strength Indicator value. This is
one of the KPlIs.

The Signal to Noise Ratio. This is one of the KPIs.

dot11radio 1/wds O
US 802.11na ch 165
Up

Up

30

30
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Table 3 Link Statistics (Continued)

mm

Noise Floor The noise floor information. -117 dBm
Data Rate Data rate value of the link. 130 Mb/S
Link Quality The link quality value. This is one of the KPlIs. 83%
Security Policy The encryption mode used. WAP2
Current Tx Rate The amount of traffic on the link at any given time.  3.13 Kb/s

NOTE

You can get a quick view of the Realtime Link Information by moving the cursor over the link. This information is
displayed in a hint box, which disappears when the cursor is moved away.

Recovering Orphaned Nodes

The Orphan Node Recovery (ONR) feature is used to recover a Orphan Node (ON) and to bring it back to a
mesh network. The orphan node (ON) is a mesh node which has lost all links with the other node in a mesh
network. A neighbor node is used to initiate the creation of a configuration file and the same is transferred
to the orphan node. Check the settings on the recovered ON. The ONR feature may reset some of the
configuration settings on the recovered ON to the default settings.

The following are the prerequisites for the ONR process:

MeshOS version: The MeshOS version, both of the neighbor and the ON is MeshOS 4.3 or higher.

Topology: The transmission of messages between nodes that are separated by more than one hop is not
possible.

ON: The ON can be scanned by at least one radio in the mesh point. At least one radio of a neighbor is in
WDS mode. The MAC address of the ON is known. The MAC address can be Ethernet, radio (e.g. wifi*),
or any VAP (e.g. WDS, STA, or AP).

Neighbor node: The ON and its neighbor are able to communicate at the physical layer with a RSSI
greater than 15.

To recover an ON, identify a neighbor of the ON and run the ONR feature from the neighbor node as shown
in Figure 56.

| Map View
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Figure 56 Orphan Node Recovery

The following operations can be performed on each node in the mesh topology map:

Query

Modify

Configuration

WMI

Save Router Location

Update Status

Query
The following parameters can be queried at each node:
Alert
Property
System Statistics
Interface Statistics
Client Statistics
In addition to the above the result of the following commands can also be viewed:
Ping
Trace Route
To access the Query operation:
1. Right click on the node.
2. Select the Query option and the desired sub option (for example, Query > Client Statistics).
3. A separate pop-up window displays the results of the query.

Modify
The Modify operation allows you to modify the following node details:

Hostname
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| Map View

IP Address

You can use the Delete option to delete a node from the mesh network.

Configuration
To access the Configuration operation:

1. Right click on the node.

2. Select the Configuration option and the desired sub option (for example, Configuration > Set as
Gateway).

The following configuration options are available at the nodes:
Set as Gateway
Set as Non-Gateway
Set Preferred Link
Unset Preferred Link
Disallow Link
Allow Link
Clear Auto wds Policies

Recovery Orphan Nodes

WMI
This node operation provides direct links to the following WMI pages of the router:
Home
Radio Interface
DHCP Server
Routing Table
AVT

Troubleshooting

Save Router Location

This node operation saves the current location of the node in the mesh topology map.

Update Status

This node operation updates the status of the router.

The following operations can be performed on each mesh network in the topology map:
Open Network: Opens the map of the mesh network.
Save Map Location: Saves the location of the mesh network in the mesh map.
View Clients: Shows details on the clients connected to the mesh network

Update Status: Updates the status of the mesh network.
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Figure 57 Mesh Operations
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Chapter 4

Provisioning

The Provisioning page includes the functions used for mesh configuration and upgrade. This chapter
includes instructions on how settings and operations common to an entire mesh network are performed.
The Provisioning page consists of the following features:

e “Import” on page 55

e “Configuration” on page 56
e “Backup” on page 73

e “Restore” on page 74

e “Audit” on page 76

Import
This function allows you to import the configuration of a router into the MeshConfig tool.
To import the configuration:

1. Click on the Import link to open the Import page.
2. Select the Mesh ID from the drop down list and one router in the selected Mesh ID.
3. Click on the Import button as shown in Figure 58.

The configuration of the selected router is imported to the MeshConfig tool.

Figure 58 Import Page

E Import an existing configuration from a mesh node before proceeding with the configuration of the mesh network.
NOTE
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The network-wide settings can be accessed via the Configuration feature. The settings configured here are
sent to all the nodes associated with the selected Mesh ID.

Figure 59 Configuration Page

The configuration feature consists of the following settings that are available as separate tabs on the
Configuration page:

“System Tab” on page 57
“Mesh Tab” on page 58
“Radio Tab” on page 60
“SSID Tab” on page 63
“SNMP Tab” on page 69
“Syslog Tab” on page 70
The following options are common to all the tabs in the Configuration page:
Save button—Saves the configuration changes to a single configuration file.

Click on the Save button in the Configuration page to save all the configuration settings into a single
configuration file.

Configure button—Applies the configuration changes to the nodes.

Report button—Displays a report on the configuration status.

The Save button saves the configuration changes in the configuration page to a single configuration file.

NOTE

Additionally, an AP filter as shown in Figure 60 is available. With this option, you can configure all the APs
in a mesh network by configuring one of the APs.
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Figure 60 AP Filter
MESIDCOMIMEG ... | | swmor | | s | o | o | sy |

Provisioning Configuration
% _Configuration [ MeshiD
ﬁ% Current Mesh ID1s  DefaultMesh All Routers Filter
. _Backup
e Mesh > RDevice Select
% _Restore
Regulatery Domain United States Current Mesh ID |s: DefaultMesh
% _Impaort Public Safety @ Enable () Disa O Serial Number  Router ID Hostname Ip Address Type Reachability
\f
—— & indoor @ outad | D 425507200078} 10.0.0.180  CAM-A-180  10.65.12.180 Galeway Yes
N nstallation Type ) Indoor '@ ul
] 00053 10011151 MST200-Ob-  10.B514.14 AP No
« _Audit a7.06 —
] 6442411200015 0.0.0.0 MSA1100 10651413 Galeway Yes bstore Links |

The following steps illustrate how to configure all the routers in a mesh network by selecting one of the APs
and using the AP filter:

1. Click on the Filter option in the Mesh ID Selection section of the Configuration page.
A pop up window with the list of all the APs in that mesh network is displayed.

2. Select one of the APs and click on the Save button.
The All Routers Filter changes to Part Routers All

3. Click on the All option to configure all the routers in the mesh network.

System Tab

The System tab is the default tab that is displayed on the Configuration page. You can configure the
Country code, Installation Type, and perform network maintenance functions using the System tab.

Figure 61 Systems Tab
Mesh \I Radio \I SSID \I SNMP \I Syslog

Regulatory Domain United States -
Public Safety @ Enable ) Disable Routers must be reboot after changed.Routers must be authorized to use 4.9G
Installation Type ) Indoor @ Qutdoor Routers must be reboot after changed
[ Resot

The system configuration settings are listed in Table 4.

Table 4 System Tab Settings

mm

Regulatory Domain The regulatory domain code United States
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Table 4 System Tab Settings

mm

Public Safety Enables or disables the public safety feature. This Disabled
setting is applicable only for the United States and
Japan regulatory domains. Using this option you
can enable the 4.9 G spectrum for use in the public
safety domain.

NOTE: This option requires a router reboot to take

effect.

Installation Type The installation type - Indoor or Outdoor The default for MSR1200 is
NOTE: This option requires a router reboot to take  Indoor and the default for
effect. MSR2000, MSR4000, and

MST200 is Outdoor.

Click on the Configure button to apply the configuration. A configuration report tracks the progress of the
configuration. When the configuration is complete, “Apply Success” is displayed for all the nodes.

The following maintenance functions are also available at the click of a button:

o Reboot—Reboots the routers.

o Reset—Resets the routers to the factory default.

Mesh Tab

This tab consists of the Mesh settings. You can configure the Mesh ID and the Backhaul Security Mode
using this tab.

Figure 62 Mesh Tab

System Radio 551D ~J  swmp ]  sysleg
Mesh 1D chenjial11
Backhaul Security Mode @ No Security 0 WEP ) wra T wPaz

The mesh configuration settings are listed in Table 5.

Table 5 Mesh Tab Settings

mm

Mesh ID The Mesh ID of the network being configured. -
Backhaul Security The backhaul security mode: No Security
Mode o No Security

o WEP

o WPA

o WPA2
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Click on the Configure button to apply the configuration.
To configure backhaul security mode:

1. Choose the security mode (No Security, WEP, WPA, or WPA2).

2. You will be presented with additional configuration options based on the security mode selected, as
illustrated below:

WEP
Additional configuration options as shown in Figure 63 should be configured for the WEP security mode.

Figure 63 WEP Settings

Key
WEP Mode @ open U Shared
Key Type @ ascn O HEX

Cefault Key 1w

WEP Key1 l:l WEP Key should be 5, 13 or 16 character string or 10, 16 or 32 digits hex.
e —
e —
L —

The WEP settings are listed in Table 6.

Table 6 WEP Settings

mm

WEP Mode o Open—Open authentication. open
Shared—Shared key authentication.

Key Type o ASCI ASCII
Hex
Default Key WEP default key. Range is 1-4. 1
WEP Key <1-4> WEP Key should be 5, 13, or 16 character string or = N/A (Not applicable)

10, 16, or 32 digit hexadecimal.

WPA
Additional configuration options as shown in Figure 64 should be configured for WPA security mode.

Figure 64 WPA Settings

Key

Key Type @) asci ) HEX

WPA Key l:l WPA Key should be 8-63 character string or 64 digits
hex.

The WPA settings are listed in Table 7.
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Table 7 WPA Settings

mm

Key Type o ASCII ASCII
o Hex
WPA Key WPA Key should be a 8 - 63 character stringora 64 -

digit hexadecimal.

WPA2

Additional configuration options as shown in Figure 65 should be configured for WPA2 security mode.

Figure 65 WPA2 Settings

WRAZ Key

Key Type @ HEx 01 Ascl

WPAZ Key l:l WPAZ Key should be 2-83 character string or

B4 digits hex.

WIFAZ Preauth ) Enable @ Disable

The WPA2 settings are listed in Table 8.

Table 8 WPA2 Settings

mm

Key Type o ASCII ASCII
o Hex
WPA2 Key WPA2 Key should be 8-63 character string or 64 -

digit hexadecimal.

3. Click on the Configure button to apply the configuration.

Radio Tab

This tab consists of the Radio settings. The settings apply to a specific radio on all nodes in the network. For
example, if the radio index is set to 0, the other settings on this tab are applied to radio 0 of all nodes in the
network, assuming that they do not conflict with any existing configuration.
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Figure 66 Radio Tab
System [ wesh JINCETRNN[  sso [ swe [ sysieg

Radio Index 0w

WDS Auto O Max Auto WDS 4 ¥

Radic Mode 202.11blg -

Channel List 802.11bg Channel list seperated with comma. eg. 1, 25,7
Channel List 802.11a Channel list seperated with comma. e.g. 26, 80, 100, 148
‘Output Power SD_V

The radio settings are listed in Table 9.

Table 9 Radio Tab Settings

mm

Radio Index 0-3; 0 stands for RadioO interface -

WDS Auto Used to enable or disable the Auto WDS Meshing -
feature.

Max Auto WDS The range is 1-6. 4
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Table 9 Radio Tab Settings

mm

Radio Mode Configures the wireless settings of the radio 802.11b/g
interface.

802.11a

802.11b

802.11b/g: Compatible with 802.11b.
802.11na 20 MHz

802.11ng 20 MHz

802.11na 40 MHz Plus: Combines two
neighboring 20MHz channels into one 40MHz
channel. The control channel is the configured
channel, and the frequency of the extension
channel is higher than that of the control
channel.

802.11na 40 MHz Minus: Combines two
neighboring 20MHz channels into one 40MHz
channel. The control channel is the configured
channel, and the frequency of the extension
channel is lower than that of the master channel.
802.11ng 40 MHz Plus: Combines two
neighboring 20MHz channels into one 40MHz
channel. The control channel is the configured
channel, and the frequency of the extension
channel is higher than that of the control
channel.

802.11ng 40 MHz Minus: Combines two

neighboring 20MHz channels into one 40MHz

channel. The control channel is the configured

channel, and the frequency of the extension

channel is lower than that of the control channel.

802.11g-only: Not compatible with 802.11b.
NOTE: g mode is compatible with 802.11b mode;
g-only mode is not compatible with the 802.11b
mode. ng, ng-ht40plus, ng-ht40minus mode is
compatible with 802.11g; na, na-ht40plus, na-
ht40minus mode is compatible with 802.11a. By
default, the MSR/MSA only support 802.11b/g,
other modes need license.

Channel List 802.11bg  Specifies the channel list or channel numbers for -
the 802.11bg mode.
Valid channel numbers: 100 104 108 112 116 120
124 128 132 136 140.
Multiple channel numbers in the list are separated
by commas. For example 100,104.

Channel List 802.11a Specifies the channel list or channel numbers for -
the 802.11a mode.
Valid channel numbers: 100 104 108 112 116 120
124 128 132 136 140.
Multiple channel numbers in the list are separated
by commas. For example 100,104.

Output Power Power of the radio as a percentage of full power. 50
Antenna Gain Configures the antenna gain. The range of valueis 0
0-255.

NOTE: This parameter is usually set during
deployment and is usually not changed thereafter.
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Click on the Configure button to apply the configuration.

SSID Tab

This tab is used to create and manage the SSID settings. All the SSIDs in the mesh network are listed here
with details as shown in Figure 67.

Figure 67 SSID Tab

System [ Mesh [ Radio  JENECCRNNN] swwp [ sysog

~ 551D edit
551D Description BSS5 Number Security Mode Radio
T

Creating a New SSID

To create a new SSID:

1. Click on the New button in the SSID tab. The SSID configuration page is displayed as shown in Figure
68.

Figure 68 SSID Configuration

SSID

BSS Number o |0t 15, san netreduplicate

Radia D_V

Security Mode @ Hone ) wEP (00 wPa (D) wPA2 170 Radius Client
| seve |

2. Specify the configuration parameters.

The SSID configuration settings are listed in Table 10.

Table 10 SSID Configuration Settings

mm

SSID The 802.11 SSID for the BSS. -
Description Description of the BSS. -
BSS Number BSS interface index. Range is 0-15. 0
Radio Radio index. Range is 0-3 0
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Table 10 SSID Configuration Settings

mm

Security Mode Security mode of the BSS Interface: -
o None

WEP

WPA

WPA2

Radius Client

3. You will be presented with additional configuration options based on the security mode selected as

illustrated below:
WEP

Additional configuration options as shown in Figure 69 should be configured for the WEP security mode.

!:igure 69 SSID WEP Settings
WEP Key

- WEF Made @ Open 71 Shared
Key Type @ HEx T AscH

Default Key 1w

l:l WEF Key should be 5, 13 or 16 character

string or 10, 16 or 32 digits hex.

ke

- —

- —

- E—
_

< il | »

Table 11 SSID WEP Settings

mm

WEP Mode o Open—Open authentication. open
Shared —Shared key authentication.

Key Type o ASCI ASCII
Hex
Default Key WEP default key. Range is 1-4. 1
Key <1-4> WEP Key should be 5, 13, or 16 character string or = N/A (Not applicable)

10, 16, or 32 digit hexadecimal.
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WPA

Additional configuration options as shown in Figure 70 should be configured for WPA security mode.

Figure 70 SSID WPA Settings

WPA Key

Key Type @ HEX ) ASCH
WP A Ky l:l ‘WPA Key should be 8-63 character string or
B4 digits hex.

Table 12 SSID WPA Settings

mm

Key Type o HEX HEX
o ASCII
WPA Key WPA Key should be a 8 - 63 character stringora 64 -

digit hexadecimal.

WPA2

Additional configuration options as shown in Figure 71 should be configured for WPA2 security mode.

Figure 71 SSID WPAZ2 Settings

WRAZ Key

Key Type @ HEx 01 Ascl

WPAZ Key l:l WRAZ Key should be 8-83 character string or
B4 digits hex.

WPAZ Freauth Z) Enable @ Disable

Table 13 WPA2 Settings

mm

Key Type o HEX HEX
o ASCII

WPA2 Key WPA2 Key should be 8-63 character string or 64 -
digit hexadecimal.

WPA2 Firewall o Enable Disable
o Disable

Radius Client

Additional configuration options as shown in Figure 72 should be configured for Radius Client.

MeshConfig 4.4 | User Guide Provisioning | 65



Figure 72 SSID Radius Client Settings

Radius

Radius Client WPA Type @ kA D WRAzZ

Radius Auth Server [P ]
Radius Auth Part ]
Radius Auth Secret l:l
Radius Acct Sener IP l:l
Radius Acct Part ]
Radius Acct Secret l:l

Table 14 SSID Radius Client Settings

mm

Radius Client WPA o WPA
Type o WPA2

Radius Auth Server IP  IP address of the radius authentication server.

Radius Auth Port Port number of the radius authentication server.

Radius Auth Secret Secret key string of the radius authentication server.

Radius Acct Server IP  IP address of the radius accounting server.
Radius Acct Port Port number of the radius accounting server.

Radius Acct Secret Secret key string of the radius accounting server.

4. Enter the security parameters.

WPA

5. Click on the Advanced button to display the advanced settings as shown in Figure 73.
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Figure 73 SSID Advanced Settings

Hide 551D 71 ves @ Hao

WA Status @ Enable ) Disable

Station Isalation T Yes @ No

Station dle Timeout =00 (zeconds)
Qos

Access Traffic Type Mone -

Max Client Allowed 255

Per Client Max Upstream Rate Unlimted  w

Fer Client Max Downstream Rate  Unlimited  w

Fer Client Upstream Burst Size KBytes)
Fer Client Downstream Burst Size KEIy'tes)
LAN

VLAN Number b s
Mac List

Mac List Type @ No ) Accept ) Deny

-
The MAL list I there are multiple MACs, each MAC must

beina newline.

The SSID advanced settings are listed in Table 15.

Table 15 SSID Advanced Settings

mm

Hide SSID o Yes —The BSS ID is not broadcast. Clients No
cannot scan the SSID of the BSS. If a client
needs to connect to this BSS, it needs to
specify the SSID.

o No —The SSID is broadcast periodically so that
the clients can scan for the SSID.

WMM Status Enables or disables WMM service Enable

Station Isolation o Yes —Prevents the stations under the BSS from No
communicating with each other.

o No —The stations under the BSS can
communicate with each other.

Station Idle Timeout Configures the maximum amount of time (15-65535 300 seconds
seconds) a station/client is allowed to be inactive
before the inactivity policy takes effect. If in this
configured time, BSS does not receive any data
from the client, BSS will disassociate itself from the
client.

None None
Best Effort

Background

Control Load

Excellent Effort

Network Control

Standard

Video Traffic

Voice Traffic

Access Traffic Type

Max Client Allowed The maximum number of clients that are allowed to 255
associate with the BSS. The range is 1-255.
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Table 15 SSID Advanced Settings

mm

Per Client Max Maximum upstream rate per client. Unlimited
Upstream Rate

Per Client Max Maximum downstream rate per client. Unlimited
Downstream Rate

Per Client Upstream Upstream burst size per client. 20 KBytes
Burst Size
VLAN Number VLAN ID. Range is 1-4094. 1
Mac List Type * No No
o Accept
o Deny
The MAC List One MAC address per line. N/A

6. Complete the configuration and click on the Save button. A new SSID is created and added to the SSID
list.

Editing a SSID

To change the configuration of an existing SSID:

1. Click on the radio button in front of the SSID to select the SSID from the list.
2. Click on the Edit button as shown in Figure 74.

Figure 74 SSID Edit

3. The SSID configuration page is displayed.
4. Edit the configuration and click on the Configure button to apply the changes.

Deleting a SSID
To delete a SSID:

1. Click on the radio button in front of the SSID to select the SSID from the list.
2. Click on the Delete button as shown in Figure 75. The SSID is deleted from the list.
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Figure 75 SSID Delete

SNMP Tab

This tab consists of the SNMP settings such as SNMP communities and SNMP trap receivers as shown in
Figure 76.

Figure 76 SNMP Tab

System [ Mesh [ Redio [ sso O ENETTRNEN[ el

Read C i public
Wirite C i private
~ Trap i edit
Receiver IP Description Trap Type
[ e

The SNMP configuration settings are listed in Table 16.

Table 16 SNMP Tab Settings

mm

Read Community Access to the SNMP Read-only community. public

Write Community Access to the SNMP Read-write community. private

Creating a Trap Receiver

To create a trap receiver:

1. Click on the New button in the Trap receiver edit section of the SNMP tab. The Trap Receiver
configuration page is displayed as shown in Figure 77.
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Figure 77 Trap Receiver Configuration

Trap Receiver

Trap Receiwver

Trap Type vic w

The trap receiver configuration settings are listed in Table 17.

Table 17 Trap Receiver Settings

mm

Receiver ID The trap receiver ID -
Description Description of the trap receiver -
Port The port number used by the receiver. -
Community The SNMP community. -
Trap Type The SNMP trap type: vic

e vic

o Vv2c

o Vv2i

2. Configure the trap receiver settings and click on the Save button to add a new trap receiver to the list.

Editing a Trap Receiver

To change the configuration of an existing trap receiver:

1. Click on the radio button in front of the trap receiver to select it from the list.
2. Click on the Edit button. The Trap Receiver configuration page is displayed.
3. Edit the configuration and click on the Configure button to apply the changes.

Deleting a Trap Receiver

To delete a trap receiver:

1. Click on the radio button in front of the trap receiver to select it from the list.

2. Click on the Delete button. The trap receiver is deleted from the list.

Syslog Tab

This tab consists of the Syslog settings such as logging status, severity, and server settings as shown in
Figure 78.
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Figure 78 Syslog Tab

System [ Mesh [ Redio [ ssm [ swee  IETERNEN

Logging Status ) on @ off

Syslog Severity Emergency

~ Syslog server edit

Syslog Server IP Description
T BT T

The syslog configuration settings are listed in Table 18.

Table 18 Syslog Tab Settings

mm

Logging Status o On off
Off

Syslog Severity Emergency Emergency
Alert

Critical

Error

Warning

Notice

Informational

Debug

Creating a Syslog Server IP

To create a Syslog Server IP:

1. Click on New button in the Syslog Server edit section of the SNMP tab. The Syslog Server
configuration page is displayed as shown in Figure 77.

Figure 79 Syslog Server IP Configuration

Syslog Server

Syslog Server

The syslog server configuration settings are listed in Table 19.

Table 19 Syslog Server Settings

mm

Syslog Server IP The syslog server ID. -
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Table 19 Syslog Server Settings

mm

Description Description of the syslog server. -

2. Configure the syslog server settings and click on the Save button to add a new syslog server to the list.

Editing a Syslog Server
To change the configuration of an existing syslog server:

1. Click on the radio button in front of the syslog server to select it from the list.
2. Click on the Edit button. The Syslog Server configuration page is displayed.
3. Edit the configuration and click on the Configure button to apply the changes.

Deleting a Syslog Server

To delete a syslog server:

1. Click on the radio button in front of the syslog server to select it from the list.

2. Click on the Delete button. The syslog server is deleted from the list.

Configuration Report

All the configuration changes are sent to the Configuration report for tracking when you click on the
Configure button.

To view the Configuration report:

Click on the report button in the Configuration page. The configuration report is displayed as shown in
Figure 80.

Figure 80 Configuration Report

The progress of the configuration tasks is indicated in the Progress column. Successful configuration is
indicated by “100%” and a failed configuration by “Failed” in the progress column.

The Total progress bar indicates the average progress of all nodes. You can also view the detailed
configuration report for each configuration task.

To view the detailed configuration report:

Click on the link in the progress column for that task. The detailed configuration report opens in a separate
pop up window. The detailed report includes the CLI and configure log that are generated as shown in
Figure 81.
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Figure 81 Detailed Configuration Report

| | Configure and run the report once and wait for the configuration progress for each AP to complete (100% or fail),

T before viewing the detailed report. This is to ensure that the AP log details are current.

MeshConfig supports the backup of configuration data of the routers.
To backup the configuration of a router:
1. Navigate to Provisioning > Backup to open the Backup configuration page as shown in Figure 82.

Figure 82 Backup

Input the Package Name and Description.

Select the devices to be backed up by checking the box in front of the devices.
Click on the Backup button.

Click on OK in the confirmation dialog that is displayed

S T W

The backup report is displayed as shown in Figure 83.
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Figure 83 Backup Report

Backup Report

Total Progress:

Total : & Success. & Failure 0o

I Address

Serial Number
0011
12A12093100038
12A12053100020
1ZA1Z032100084
34BO2104500001
B1A12032800021

The Progress column shows “100%” for a successful backup and “Failed” for the unsuccessful ones. Total
progress indicates the average of the progress at all the nodes.

Click on the link in the progress column to view the detailed backup report. This report is displayed in a
separate window and includes the backup CLI and the backup log.

Figure 84 Detailed Progress Report

zhiyuan-5 Backup Detail

Backup CLT from Router

configure terminal

I

4.3.0.1 Configuration File

- MeshConfiy is backuping configuraion frem A
48 - MeshConfiy backuped configuraion success frem A

Uploading the settings to the MeshConfig tool and writing the same to a file may take several minutes. Wait until
T the Progress column for all devices in the Backup Report shows “100%” before proceeding further.

MeshConfig supports restoring of a configuration file to the routers.
To restore a configuration file to a router:
1. Navigate to Provisioning > Backup to open the Restore configuration page as shown in Figure 85.

Figure 85 Restoring a Backup File
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2. Select a package in the Package Selection section and click on the Continue button. The Restore
page is displayed as shown in Figure 86.

Figure 86 Restore Page

Restore
Device Selection

Device Name IF Address Mesh 1D Serial Number Router Model Type Reachability

zhiyuan§ 10.65.12.218 zZhiyuzn-mesh E1A12032800021 MSR2000 AP Yes

3. Select the devices to be restored by checking the box in front of the devices and click on the Restore
button.

4. In the confirmation dialog that pops up, click on the OK button. The Restore Report is displayed as
shown in Figure 87.

Figure 87 Restore Report

The Progress column shows “100%” for a successful restore and “Failed” for the unsuccessful ones. Total
progress indicates the average of the progress at all the nodes. Click on the link in the Progress column to
view the detailed report as shown in Figure 88.

Figure 88 Restore Detailed Report

| | Downloading the settings to each device and writing the same to its flash partition may take several minutes. Wait

T until the Progress column for all devices in the Restore Report shows “100%” before proceeding further.
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MeshConfig allows you to audit the configuration for selected devices on the network and generate an audit
report. This feature is used to compare the configuration of an AP with that of the MeshConfig tool. The
audit report lists the difference between the configurations.

To audit a node in a mesh network:

1. Click on the Provisioning tab to open the provisioning page.

2. Click on the Audit link in the menu tree to open the Audit page as shown in figure

Figure 89 Audit Page

3. Select the router (s) that you want to audit by checking the box in front of the router in the Device
Selector section as shown in Figure 90.

Figure 90 Selecting Routers for Audit

4. Click on the Audit button to start the audit process. The audit report is displayed as shown in Figure 91.
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Figure 91 Audit Report

5. Click on the link in the progress column once the progress shows “100%”.

6. The detailed audit report as shown in Figure 92 is displayed in a separate window.

Figure 92 Detailed Audit Report
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Chapter 5

Network Maintenance

This chapter contains instructions on how maintenance activities are performed in the network. The
following topics are covered:

e “Checking Active Alarms” on page 79
e “Checking History Alarms” on page 81
e “Upgrading Nodes” on page 82

e “Online Client” on page 86

e “Adding a Node” on page 86

e “Adding a Mesh Network” on page 86
e “Auto Discovery” on page 87

e “Discovery Parameters” on page 88

e “Global Configuration” on page 89

e “Network Report” on page 89

e “Rebooting a Network” on page 90

e “Resetting Nodes to Factory Default” on page 91

Checking Active Alarms
MeshConfig can display a list of active alarms that indicates problems in the network.

To view the list of active alarms, click on the Alert tab as shown in Figure 93 to open the Real time Alert
page.

The Real time Alert page also allows you to search the list of alarms using the Search option. You can
filter the alarm list based on the following attributes:

e Source

o Category
o Message
o Severity

o Date /time

Figure 93 Alert Tab

Change Password | Lo
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@ e e
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[

A ﬁ% _History Alert

E E E

E B
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Most alarms occur when nodes become unreachable in the network. MeshConfig allows you to debug the
situation by opening the WMI of the neighbor node.

To open the WMI of the neighbor node of a device:
1. Open the topology map and find a working node that has a link to the failing node.
2. Right-click on that neighbor node and select the menu option WMI > Troubleshooting.

Figure 94 Troubleshooting a Node

3. The WMI of the node is displayed in a new web browser window.
Check the browser settings to see if pop-ups are being blocked, if this window does not open.
4. Enter the username and password for the node in the login dialog that is displayed.

The default is “root” and “public”.

Figure 95 WMl login

The WMI Troubleshooting Tools for the neighbor device opens as shown in Figure 96. This page has
many troubleshooting utilities available to help determine the cause of the failure, either in the current
node, or in the neighboring nodes.
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Figure 96 Troubleshooting Tools in MeshOS WMI
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Refer to the Aruba MeshOS 4.4 User Guide for detailed information on the troubleshooting options.

NOTE

MeshConfig stores and displays the list of history alarms of problems that have occurred in the network.
You can configure the duration of storage for the history alarms.

To view the list of history alarms:

1. Click the Alert tab to open the Alert page.

2. Click on the History Alert link in the menu tree. A list of history alarms is displayed as shown in Figure
97.
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Figure 97 Alarm History

Change Password |

Alert

-. History Alert

.@. _Real-time Alert

Histoi Alert

Page Length 25w 1to2sofassat] | I D Column Severity ¥ Contain
Severity  Source

Category Date / Time

Message

Critical zhiyuan-6 Operation  14:55:44 20-09-2011 Router zhiyuan-6 cannot be pinged.
Critical zhiyuan-2 Operation  14:55:47 20-09-2011 Router zhiyuan-2 cannot be pinged.
Critical zhiyuan-3 Operation  14:55:54 20-09-2011 Router zhiyuan-3 cannot be pinged.

The History Alert page also allows you to search the list of alarms using the Search option. You can filter
the alarm list based on the following attributes:

o Severity
e Source
o Category

o Date/time

o Message

Upgrading Nodes

The MeshConfig allows a single node or multiple nodes within a mesh network to be upgraded at the same

time.

To upgrade a node:

1. Click on the Upgrade tab to open the Upgrade page as shown in Figure 98.

82 | Network Maintenance
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Figure 98 Upgrade Tab

The Image Selection section displays all the image files that have been saved in the system. Use the Upload

option available on the page to upload image files in the case of a new installation.
NOTE

2. If the upgrade image file that you require is already in the list, skip Steps 2-6 and proceed with Step 7. If
the image file is not available in the list, click on the Upload button to open the Image Upload page as
shown in Figure 99.

Figure 99 Uploading Image File

3. Click on the Browse button to browse the location of the file as shown in Figure 100.

Figure 100 Browsing the Image File
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4. Browse to the location of the device image file (for example, c:\MeshOS_Images) and select the image
file.

Figure 101 Selecting the Image file for Upload

Alternatively, select the remote option and specify the remote location details of the image file.

5. Click on the Submit button to upload the image file to the tool as shown in Figure 102.

Figure 102 Upload of Image File

6. Select the image file and click on the Upgrade Nodes button to open the Select Device page as shown
in Figure 103.

Figure 103 Select Device Page

| ] You may not see all of the nodes in this list because the upgrade tool only displays the devices that are compatible

with the image file selected.
NOTE

7. Select the devices to be upgraded by checking the box in front of them and click on Next Step.

| Network Maintenance MeshConfig 4.4 | User Guide



Figure 104 Selecting the Nodes for Upgrade

8. In the confirmation dialog that is displayed, click on OK to confirm the upgrade. A upgrade report is
displayed as shown in Figure 105.

The Progress column in the report shows “100%” on successful completion of the upgrade or “Failed” in
all other cases. The Total progress bar indicates the average of the progress in all the nodes.

Figure 105 Upgrade Report

Click on the link in the progress column to view the detailed upgrade report as shown in Figure 106. The
detailed report is displayed in a separate pop up window and includes the upgrade log.

Figure 106 Detailed Upgrade Report

Downloading the new software image to each device and writing the same to its flash partition may take several
minutes. Wait until the Progress column for all devices in the Upgrade Report shows “100%” before proceeding
NOTE further.
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You can view a list of online clients in MeshConfig.

To view the list of online clients, click on the Client tab to open the Connected Clients page as shown in
Figure 107. A list of all the online clients is displayed.

Figure 107 Client Tab

Change Password | Log

WMesiCamniiie
Home | Map | Inventory | Alert | Provisioning | Upgrade | Client | System | Report
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@ _Connected Clients
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00177b:2a:6d:45 24442 n-3 61 270376892 1712464 298 Mbls 1827 Kbis 3.11 Mbis 2018 Kbls 14:54'52 20-09-2011 11
00:17:7b:2a:66:af 192.168.11.11 zy6 56 425022 6626 1.29 Kbis 0 Kbis 0.86 Kbls 0.01Kbis 14:01:39 20-09-2011 64

This option adds a node with the specified IP address to the MeshConfig Tool.

To add a node:
1. Click on the System tab to open the Add Node page as shown in Figure 108.

Figure 108 Adding a Node

2. Enter the IP address in the box provided and click on the Submit button.
MeshConfig will discovery this node by its IP address and add it to the list.

This option adds a mesh network with the specified gateway and parameters to the MeshConfig tool.
To add a mesh network:
1. Click on the System tab to open the System page

2. Click on the Add Mesh Network link in the menu tree to open the Add Mesh Network page as shown in
Figure 109.
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Figure 109 Adding a Mesh Network

3. Enter the Gateway IP in the box provided.
4. (optional) Click on the Advanced link to access additional settings.
5. Click on the Add Mesh button.

MeshConfig adds the gateway node to its list and starts managing the gateway node as well as any other
node that is in the same mesh network.

This option automatically discovers and adds mesh networks based on the specified IP or a range of IPs
with the netmask.

Click on the System tab and select the Auto Discovery option from the menu tree to display the Auto
Discovery page as shown in Figure 110.

Figure 110 Auto Discovery

To add a auto discovery request:

1. Click on the Add button in the Auto Discovery page to display the auto discovery parameters as show
in Figure 111.
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Figure 111 Adding an Entire Network

2. Enter the Network Address and Netmask details and click on Submit.
MeshConfig discovers all the nodes within this network using the Network Address.
3. Alternatively, click on the Add range of Nodes option located on the right side of page as shown in

Figure 112.

Figure 112 Adding a Rage of Nodes

Enter the Start IP Address, End IP Address, and Netmask. Click on the Submit button. MeshConfig will
discovery all the nodes within this network between the specified Start IP and End IP.

Discovery parameters such as SNMP Timeout, SNMP Retries, and enable/disable Auto Discovery
option can be configured in the System tab.

To access these settings:
1. Click on the System tab to open the System page.

2. Click on the Discovery Parameters link in the menu tree to display the Discovery Configuration
Settings as shown in Figure 113.

Figure 113 Discovery Configuration Settings

Discovei Confiiuration Settinis

Common Parameters
Auta Discovery
SNMP Properties
SNMP Timeout 2 ¥ second(s)

SNWP Retries 0 -

3. Configure the parameters and click on Submit.
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The Global Configuration page lets you configure global parameter such as:

SNMP Polling

You can configure device status polling parameter and performance data polling parameter.
SNMP Parameter

HTTP parameter

These parameters are used for the backup, import, and audit functions. MeshConfig requests MeshOS
for the CLI file of the AP with the User Name and Password configured in this section. The default
username is root and password public.

The username and password configured here should match with the MeshOS username and password. The

NOTE backup, import, and audit operations will fail if the parameters do not match.

Historical Data Retention

You can configure a duration for storing the data generated such as reports. A duration in days starting
from 1 day and up to 90 days is allowed.

To configure the global parameters:

1. Click on the System tab to open the System page.

2. Click on the Global Configuration link in the menu tree to display the Global Configuration settings
as shown in Figure 114.

Figure 114 Global Configuration Settings
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Expire Report Data Older than Days

3. Configure the parameters and click on Submit.

You can view detailed reports on devices, links, interfaces, and clients in the MeshConfig tool. Let us take
the Radio Link Quality Report as an example.

1. Click on the Report tab to display the Report page as shown in Figure 115.
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Figure 115 Report Tab
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2. Click on the Radio Link Report > Radio Link Quality Report link in the menu tree on the left panel
to display the report in the Report Detail section as shown in Figure 116.

Figure 116 Radio Link Quality Report - Example
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3. Use the Report Generator section to modify the Start Time, End Time, and Sort by parameters.

You can specify a time range for the stored statistics and limit the data displayed to a particular router.
The default setting is the past 24 hours and all routers.

Start Time: The start time to be searched.
End Time: The end time to be searched.
Sort by: You can sort the search result by options available in the drop down list.

4. Click on the Generate button to (re)generate the Radio Link Quality Report

To reboot all nodes in the network:

1. Navigate to Provisioning > Configuration > System tab.

2. Click on the Reboot button.
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Figure 117 Rebooting Network Nodes
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3. Click OK in the confirmation dialog that is displayed

All the nodes in the network will reboot.

It is normal for MeshConfig to lose connection to the nodes when they are rebooting. Messages or alarms

N4 such as “unreachable” or “cannot ping” may appear in the Alert list.

To reset nodes in a network to the factory default:

1. Navigate to Provisioning > Configuration > System tab.

2. Click on the Reset button.

Figure 118 Resetting to Factory Default
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3. Click on OK in the confirmation dialog that is displayed

The nodes will now be reset to factory default.

MeshConfig will lose the connection to all nodes because the IP address of the master node in the
network is reset to the default IP address. Add the node to the MeshConfig tool using the default IP

NOTE address (192.168.216.1).
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